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Warning
- To reduce the risk of fire or electric shock, do not expose this appli-

ance to rain or moisture.

Caution
- The appliance is not intended for use by young children or infirm

persons without supervision.
- Young Children should be supervised to ensure that they do not

play appliance.
- Use of controls or adjustments or performance of procedures other

than those specified herein may result in hazardous radiation ex-
posure.

Disposal of your old appliance

1. When this crossed-out wheeled bin symbol is attached to a product it
means the product is covered by the European Directive 2002/96/EC.

2. All electrical and electronic products should be disposed of separately
from the municipal waste stream via designated collection facilities
appointed by the government or the local authorities.

3. The correct disposal of your old appliance will help prevent potential
negative consequences for the environment and human health.

4. For more detailed information about disposal of your old appliance,
please contact your city office, waste disposal service or the shop
where you purchased the product.

- The lithium battery contains lithium and can explode if it is not properly
handled of disposed of. 

- Replace only with a battery of the type recommended by LG.

- Caution: Danger of explosion if battery is incorrectly replaced. Replace
only the rechargeable lithium battery with Amperex Technology Ltd. or
LG, Part No.(LGEIP-A1100E) having the cell, 553450. Use of Another
Cell May Present a Risk of Fire or Explosion. 

CAUTION
RISK OF ELECTRIC SHOCK 

DO NOT OPEN

CAUTION: TO REDUCE THE RISK 
OF ELECTRIC SHOCK

DO NOT REMOVE COVER (OR BACK)
NO USER-SERVICEABLE PARTS INSIDE

REFER SERVICING TO QUALIFIED SERVICE
PERSONNEL.

This product is manufactured to comply with the EMC
DIRECTIVE 2004/108/EC and Low voltage Directive
2006/95/EC.

European representative : 
LG Electronics Service Europe B.V. Veluwezoom 15,
1327 AE Almere, The Netherlands 
(Tel : +31-036-547-8940) 
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Please follow the safety tips closely to reduce the risk of accidents or damage to equipment.
Safety instructions are divided into Warning and Caution.
Keep this manual in an easily accessible place.

Do not use the Player and connect with the
cable or AC adapter when the rain is pouring
down and thunderstorms produce lightning. 

Do not use this product while driving.

Do not operate the Player near water, dust, or
soot.

Not following the safety tips may result
in a light accident or damage.

Not following the safety tips may result
in death or serious injury.

Do not place the player near a magnet or within the
magnetic field.

Note that the player may malfunction in an electro-
static environment.

Do not disconnect the USB cable. Do not turn off the
player while the USB cable is connected. Otherwise,
the data may get lost.

Back up important data. (Note that the manufacturer
is not responsible for the loss of major data caused
by the user's mistake.)

Do not insert a metallic object (coins or hair pins,
etc.) or flammable objects in the product.
Do not drop such objects on the product either.

Do not place an object on the product. 

Keep this product away from heat.

Clean the Player with soft cloth.

Do not disassemble, repair, or remodel the product.

Do not drop  an object or give shock on the 
product.

Do not use the earphones loud while
walking,especially on the crosswalks.

Stop using earphones or lower the 
volume when you have ringing in your ears.

Careful that headphones or earphones do not
slip into the subway doors or automatic doors.

Listening to the music loud for a long time may
compromise your hearing ability.

Do not use earphones while riding bicycles
and motor cycles or driving a car.

Check the volume before using a 
headphone. If headphones are used at high
volume for more than 30 minutes, it may result
in noise induced hearing damage.

Warning Caution

Warning Caution
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Features

Portable Data Storage
Easy storage and transfer of any file type.

USB 1.1 and 2.0
You can download files at a fast speed. (USB  2.0 high speed)

LG 3D Sound
3D sound effects, low tones, and low frequency sound provide greater
sound quality.

Various background setting
Users can select a desired background image among various sup-
ported items or even create unique one to their likings. 

DVB-T
DVB-T (Digital Video Broadcasting – Terrestrial) is the DVB European
consortium standard for the broadcast transmission of digital terrestrial
television. You can enjoy high quality digital audio and digital video
broadcasting simultaneously. 

Text Viewer
Convenient display of text files (.txt) for reading on the go.

Wide 3.0" Color TFT LCD
Photos and video are reproduced in vivid detail on the highly portable
260,000 color TFT LCD.

Touch screen
You can use the menus and functions of MP3 player by touching the
LCD.

FM Reception(Optional)
With auto frequency selection feature, you can conveniently listen to
the FM radio broadcasting.

Voice Recording
With the built-in microphone, you can record your voice and FM radio
broadcasting anywhere. 

Photo Viewer
Store and display photos on the vivid display for entertaining slide
shows.

File Format Flexibility
- Music: MP3, OGG, WMA, WAV
- Video: LG AVI (The player can be only played the video files converted

via LG Media Center.), WMV
- Photo: JPG, BMP
- Text: TXT

Media Device(MTP) Mode / Removable Disk(MSC)
Mode
What is the Media Device(MTP) mode?
The MTP stands for the Media Transfer Protocol. It applies the latest
technology defined by Microsoft to support multimedia devices.
- Windows XP / SP1 or higher OS, and Windows Media Player 10 or

higher.
- To use the MSC mode, select the MSC mode in the PC Connection

Setting menu.
- If the Windows OS does not support the MTP, the player will function

in the MSC mode although the player is set in the MTP mode (Select
the MSC mode for the USB in the setup menu for Windows 2000).

What is the Removable Disk(MSC) mode?
The MSC stands for the Mass Storage Class. The device in MSC
mode functions like a portable memory.

Converting video file
MP3 player can be only played the video files converted via LG Media
Center.
For details about conversion, see the Help menu [Converting video
file] on LG Media Center.

PC Connection Setting
Media Device(MTP) Mode
You should download music files via LG Media Center or Windows
Media Player 10 or higher.
You should download video, photo, and text files via LG Media Center.
You can copy data files to the Data folder. 

Removable Disk(MSC) Mode
You can copy the Media file to the Removal Disc. (But you should
download video files via LG Media Center.)

Package  contents

- The images inserted herein are examples to make users understand
the more easily and may be little bit different from the real product.

- The contents of the product are subject to change without prior no-
tice for functional improvement.

- Contact with one of call centers supplied with this manual to buy bat-
teries.

T80 USB cable 

Software CD     Kernel type earphones          Quick Setup Guide
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* Precautions in using the touch screen

�� Do not tap on the touch screen with your fingers unclean or gloves on. 
- Otherwise, the selected function may not operate in any way. Use it with bare hands lightly. 

�� Do not press the touch screen hard to make it work. 
- If you apply too much strength, it can damage the sensor of the touch screen.

�� Touch the point that you want to work in order to operate the function correctly. 
�� Do not touch the screen with sharp objects like pins, or it cause scratches on the screen. 

1 Display screen (*Touch Screen)

2 Earphone jack

3 DVB-T antenna

4 • Power on/off  

• Hold switch ( )

5 External antenna jack(for DVB-T)

6 Microphone hole/RESET hole

7 Battery cover  

8 Volume button

9 Record (REC) button

10 USB port

10                              9      8      

1                                2           3      4          5

6

7
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Before installing the operating program
Check the specifications of your PC before using
the Player.

Minimum system requirements
- CD-ROM Drive
- Pentium Ι ΙΙ or higher level CPU / 128MB or larger memory
- 300MB or larger hard disc space, 800 X 600 mode
- Hi-color (16 bit) or higher level video card, Sound card

Operating environment
- The MTP mode is applied to the PC equipped with Windows XP

(SP1) or higher-version OS or the Windows Media Player 10/11. 
To the lower-version OS, the MSC mode is applied.

Windows Media Player 10/11
- You can download the file using Synchronize with Windows Media

Player 10/11 menu.
- For more information, see the Help menu of Windows Media Player

10/11.

LG Media Center
- Windows 2000/XP/Vista
- Windows Media Player 10/11/ Internet Explorer 6.0
- Windows Media Player or Internet Explorer will be

automatically installed during installation of the LG Media Center.
Internet connection must be connected in order to install Internet
Explorer.

About LG Media Center
The LG Media Center program is an integrated data
management program developed for users to more
conveniently use the MP3 player.

Features of the LG Media Center

You can efficiently manage music, video, and photo files through the
Media Library rule and download them to the MP3 player.

Installing LG Media Center
1 Insert the operation program CD into the CD-ROM.

2 Select [LG Media Center].

3 Read the License Agreement. Select the check box and click [Next].

4 Select the installation path and click [Next].
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5 Click [Install] to start installation.

6 After finishing the installation, click [Finish].

- You can install CODEC if it is not installed on PC.

7 Click [Start] k [All Programs] k [LG Media Center] to start the
program.

Note
- During installation of the LG Media Center, you can install the Win-
dows Media Player and the Internet Explorer for an operating envi-
ronment.

- The pop up image may be different depending on the OS of PC. 

Installation of the Adobe Acrobat
Reader
1 Insert the operation program CD into the CD-ROM.

2 Select [Adobe Acrobat Reader].

3 Follow the displayed instructions.

View the manual
1 Insert the operation program CD into the CD-ROM.

2 Select [Manual].

3 You can see the manual.

Note
You must install the Adobe Acrobat Reader to read the manual.
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To connect the USB cable
1 Connect one end of the USB cable to the USB port of the PC and

the other to the USB port of the player.

- Check whether both ends are correctly plugged in.

2 If the USB device is normally recognized after the cable is con-
nected, the following will be displayed.

- The software version is displayed on screen.

3 In case of a correct connection, an icon will be displayed on the
task bar of the PC.

- The icon shapes on the task bar may differ depending on the OS of the
PC.

Note
- In case you connect the device to PC with an extended usb cable or
non-certified usb hub, it may not operate. 

To disconnect the USB Cable
Media Device(MTP) mode
Disconnect the USB cable from the PC after checking whether a file is
transferring.
If the file is transferring, disconnect it after the transfer is completed.

Removable Disk(MSC) mode
This feature is to safely remove MP3 player from the PC after upload-
ing or downloading the files.

1 Double-click on the Remove Hardware icon on the task bar of
the PC.

2 Click [Stop] when the window appears.

3 Click [OK].

4 After a message that the large-capacity USB storage can be safely
removed is displayed, remove MP3 player from the PC.

- If the USB cable is disconnected while storing or deleting the file, the
data may get lost.

USB Connected
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To download files - MTP mode
MP3 player will be recognized as a mobile device, not a mass stor-
age, and will interwork with the Windows Media Player 10/11.

1 Connect one end of the USB cable to the USB port of the PC and
the other to the USB port of MP3 player.

- Check whether both ends of the cable are correctly plugged in.

2 The window “MTP Media Player” appears in the PC.

1) a. “Synchronize media files to this device” k “OK”

b. “Manual” k “Finish”

c. Drag the synchronizing files to the left window.

d. Click “Start Sync”.
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2) a. “Take no action” k “OK”

b. Click “LGE MTP Player T80”.

- Data folder: You can download or upload all data files.
- Media folder: You can download only the file that Windows Media Player

10 supports.

3 Drag the file to copy to the portable media drive.

Note
- When you cannot check the downloaded files on Media folder,

download it to the Data folder again.
- When you connect the device with Windows Media Player 11 or

higher version, you can download files directly to the Internal Stor-
age. That is, lower folders below the device are not separated to
Data and Media on Window Media Player 11 or higher. 

To download files - MSC mode
1 Check whether the device is connected through the MSC mode.

- [Settings] of Home Menu  k [General] k 

[PC Connection Setting] k Removable Disk (MSC)

2 Connect one end of the USB cable to the USB port of the PC and
the other to the USB port of MP3 player.

- Check whether both ends of the cable are correctly plugged in.

3 Check whether a new drive has been added in the Windows Ex-
plorer in the PC.
- The drive name may differ depending on the OS.

4 Drag the file to copy to the removable disc drive.

- Disconnecting the USB cable while the file is being copied may cause
malfunction of MP3 player.

- MP3 player will be charged when connected to the PC through the
USB cable.

- Download video files from LG Media Center.

- Download the JANUS DRM-applied files through the
Windows Media Player 10 or higher, or LG Media Center (MTP Mode
only)

- Download X-Sync DRM-applied files through the LG Media Center.

Data
Media

Data
Media
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To download files - LG Media Center
You can download from MP3 player the files you want via LG Media
Center.
For details, see the Help menu on LG Media Center.

- You can check the downloaded files in the Music, Video, Photo, or
Document folder.

- OGG files only are supported in MSC mode.

1 Connect one end of the USB cable to the USB port of the PC and
the other to the USB port of MP3 player.

- Check whether both ends of the cable are correctly plugged in.

2 Execute the LG Media Center and then click [Add Library]. 

3 [Add file/folder] k Selecting the downing file (Ex: Music file) k
[Apply] k [Ok].

4 [Music] k [Send to Device]

5 Drag the files to the [Send to Device]. 

- Or press on the bottom of the LG Media Center, you can
send the file into the player.
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MP3 player can only play the video files converted via LG Media Cen-
ter.
For details about conversion, see the Help menu [Converting video
file] on LG Media Center.

1 Execute the LG Media Center. 

2 Selecting [Tools] k [Advanced Tools] k [Convert Format].

- Or press on the bottom of the LG Media Center, you can
also activate the converting format program.  

3 In case that the converting codec is not installed or the latest ver-
sion, the pop-up window appears as below.  
Click [Ok]. 

4 Install the latest updated version.

5 Click [Ok]. 

6 Click [Add] to select a video file you want to convert.

7 Check the video file and then select conversion options.

8 Click [Start], the selected video file start converting.

- After converting, check the video file where the file is .

- For details, see the Help menu on LG Media Center.
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USB cable
MP3 player will be also automatically charged when connecting
the PC and MP3 player with USB cable.
- On the display of MP3 player, the charging status will be displayed

as follows: (Charging time : about 4 hours)

Note
- MP3 player may completely discharged first time you purchase the

product. Charge the battery first.
- Charging time may vary according to PC system requirements or op-

erating environment. If your PC is suspended, MP3 player is not
charged.

- Do not charge MP3 player for longer than 12 hours. Overcharge and
overdischarge may shorten the battery life.

- After checking  the state of a remaining battery of note book, connect
the USB cable and charge it.

- Do not charge it when the remaining battery of the note book is not
enough.

- If you transfer files on charging, the charging time will be extended.
- Charge the battery in a place with a normal temperature.
- In case you connect the device to PC with an extended usb cable or
non-certified usb hub, it may not operate. 

AC adapter(Not supplied)
1 Connect the AC adapter to the AC outlet.
2 Connect the USB cable of AC adapter to the USB port of MP3

player.

- On the display of MP3 player, the charging status will be displayed
as follows: (Charging time: about 4 hours)

Note
- Do not disconnect AC Adapter before booting of MP3 player is com-

pleted. The data may get lost.
- Use the confirmed AC adapter(EAY34275101) when you charge the

MP3 player, otherwise the MP3 player may malfunction.
- Do not charge MP3 player for longer than 12 hours. Overcharge and

overdischarge may shorten the battery life.
- Charge the battery in a place with a normal temperature.

USB Connected

Firmware Ver. S 0.42

Charging status

2

1

Power-on status

Power-off status

Charging

Charging status
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Turning on/off the power
Turning on the power

Push the power on/off switch in the direction of the until MP3 player
is turned on.

Turning off the power
Push the power on/off switch in the direction of the until MP3 player
is turned off.

Lock feature
This feature locks MP3 player to prevent it from operating when
you accidentally press a button.

1 Push the power on/off switch in the direction of the to lock MP3
player.

- Upon locked status, will be displayed on LCD. 

Upon pressing of each button, will appear for two seconds and dis-
appear.

2 Push the power on/off switch in the opposite direction of the but-
ton to unlock the device.

Reset feature
This feature is to reset the player when the MP3 player does not
operate normally.

Prick the hole with a sharp object when the MP3 player does not oper-
ate normally.

- Push the power on/off switch in the direction of the for about 10
minutes if you do not have not any sharp object. 

Changing battery
1 Pull the battery cover in the direction of the arrow and lift up gently.

2 Detach the battery and insert a new one with +/- aligned.  
3 Fit the fitting protrusion to the fitting grove of the player and push it

gently as shown below. 

Note
- Make sure to turn the player off when changing the battery. Or it may

cause errors on the DRM file playback. 
- Do not use a non-certified battery. Or it may damage the player or

battery and cause the battery to explode. 
- Contact with one of call centers supplied with this manual to buy bat-

teries.

Locked

Locked

Power On Power Off

RESET hole
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Home menu screen
You can operate various features by using the Home menu.

* Home menu screen varies according to product models (FM radio
reception is optional.)

1 Music : Moves to the music mode.

2 Movie : Moves to the video mode.

3 DVB -T: Moves to the DVB-T mode. 

4 Photo : Moves to the image mode.

5 Radio : Moves to FM radio reception mode.
(FM radio reception is optional.)

6 Text : Moves to the text mode.

7 All Files : Displays the playable total list.

8 Game : Moves to the game mode.

9 Settings : Sets the operating environment of the player.

Note

General operations of Home menu
1 Turn the MP3 player on.

- The home menu appears on LCD.

2 Press the icon of a desired menu.

3 Press the icon of selected menu.

4 Press the desired menu to move to the second level and then press
the selected menu to execute the menu.

Note
- Press to return to the previous menu during operation.

- Press and move to the right downward direction to return to the
home menu during operation.

- Press and move to the left upward direction to return to the pre-
vious menu in the home menu.

Icon of the 
selected menu

Contents of the 
selected menu

cc

bb

aa

ee

dd

hh

ii

ff

gg

The section marked as above is specified as “middle part” in
this manual.

Middle part applied in
rectangular screen
view(music/photo/text
mode)

Middle part applied in
horizontal screen view
(movie/DVB-T mode)

Applied in 
volume control
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Music playing screen

1 Moves to the previous menu or home menu.

2 Playback time

3 Bookmark display

4 Play mode display

5 Playing time bar

6 Remaining time

7 Control icons (Play/ Pause/ Skip/ FF/RW)

8 Music information display 
(Album, Artist, Title)

9 Image

10 Moves to the EZ menu.

11 Battery status

Music menu

Last Played File
Plays the last played music file.

Random play all
Plays the music file randomly.
- When you set [Random play all] during operation, the play mode is

changed to [Random all].

Playlist
• My Playlist

You can select and manage your own playlist.

• PC Playlist :
The playlist created in the WMP(Windows Media Player 10 or higher)
or the LG Media Center can be automatically displayed on the MP3
player through the Auto Sync mode.
- When the playlist and corresponding files are unchecked in the

Auto Sync mode, music will be deleted in the MP3 player. It is rec-
ommended to keep all Music files always checked.

All music
Displays the total music.

Artist
Displays the music by artist.

Album
Displays the music by album.

Genre
Displays music by genre.

Recorded File
Plays the radio recording file (Option by models) or voice recording
file.

Note
- The selected file is played when you select the desired file.

- Select a file you want and press , you can delete it.

Edit
Delete All Deletes all files in my playlist.

Adds the desired file in my playlist.Add Music

1

2

4

9

8

7

10

3

5

11

6
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Playing music files
1 Select of the home menu.

2 Select the desired menu and then press a music file you want to
play.
- If you select the [Last Played File] menu, the last played music file will

be played at once.

Pausing
1 Press the middle part of LCD during playback. 

2 Press the middle part of LCD again to resume playback.

Using the control icons

1 Press during playback to pause.

2 Press to resume playback.

Playing the previous or next file
Drag the middle part of LCD in the direction of the left/right  during
playback. 

- If you drag the LCD from right to left after five seconds of playing
time, the current file will be played from the beginning.

- If you drag the LCD from right to left within five seconds of playing
time, the previous file will be played from the beginning.

Using the control icons

Press / button to play the previous or next file.

- If you press after five seconds of playing time, the current file will
be played from the beginning.

- If you press within five seconds of playing time, the previous file will
be played from the beginning. 
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Speed search
Drag the LCD during playback and then press and hold the LCD.

Using the control icons
Press and hold / button for two seconds during playback. And
then release at a point you want.

Playing from a specific point
1 Press the playing time bar to play from a specific point you want

during playback.
- The control box appears on LCD.

2 Press / / / .

- : Moves to the point of playing time before 1 minute.
If the playing time is less than 1 minute, the current file moves to
the beginning point.

- : Moves to the point of playing time before 5 seconds.

- : Moves to the point of playing time after 5 seconds.

- : Moves to the point of playing time after 1 minute.
If the remaining time is less than 1 minute, the current file moves
to the beginning point of next music.

Volume control
Touch the screen. Then keep pressing and turn the point you press on
LCD clockwise/counterclockwise during playback.

Volume up

Volume down

Using the volume button 
Press the volume button on the right side of the player during play-
back. 

- :  Press this button to increase volume. 

- : Press this button to decrease volume.

Release at a point you want.

Release at a point you want.

24

12
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EZ menu 
You can set the desired function or switch to other modes using the
EZ menu.
Press to select the EZ menu during playback.

Bookmark
You can start playback from memorized point.
• Set : Sets the bookmark.
• Move : Executes the bookmark.
• Cancel : Cancels the bookmark.

Simultaneous View
• Photo : You can view the photo while listening to the music simulta-

neously.
[Photo] k [ (Moving to EZ menu of the photo] k
[Music] k [Cancel]/[Play Previous]/[Play Next]/[Back]
- [Cancel] : Stops the music playback.
- [Play Previous] : Plays the previous music.
- [Play Next] : Plays the next music.
- [Back] : Moves to the music mode.

• Text : You can view the text while listening to the music simultane-
ously.

[Text] k [ (Moving to EZ menu of the text] k [Music]
k [Cancel]/[Play Previous]/[Play Next]/[Back]
- [Cancel] : Stops the music playback.
- [Play Previous] : Plays the previous music.
- [Play Next] : Plays the next music.
- [Back] : Moves to the music mode.

Create My Playlist/Delete My Playlist
• When a currently playing music file is not added in Playlist, “Create

My Playlist” is displayed. 
• When a currently playing music file is added in Playlist, “Delete My

Playlist” is displayed. 

Play Mode
• Repeat One

Plays the current file repeatedly.
• Play All

Plays all music within the selected folder in order.
• Repeat All

Plays all music within the selected folder repeatedly.
• Random All

Plays all music within the selected folder randomly.
• Random Repeat All

Repeats all music within the selected folder randomly.

Sound Effect
You can set sound effect by selecting EQ or 3D Sound. 
• EQ: AUTOEQ, NORMAL, POP, ROCK, R&B/SOUL, HIPHOP/RAP,

JAZZ, CLASSICAL, DANCE, LIVE, USER EQ
• 3D Sound: Off, CLEAR, 3D EXPANDER, STADIUM, CONCERT

HALL, CLUB, ROOM, BASS BOOST, X-LIVE 

Delete File
• Yes : Deletes the playing file.
• No : Cancels the deleting of playing file.

View Information
Displays the information of the playing file.
(Bitrate, File Size, Sampling, Codec, Setting)
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Movie playing screen

1 Moves to the EZ menu.

2 Moves to the control box. 
(Play/ Pause/ Skip)

3 Battery status

4 Title of the video file

5 Moves to the previous menu or home menu.

6 Bookmark display

7 Playback time

8 Playing time bar

9 Remaining time

10 Playing screen

Playing movie files
MP3 player can only play the video files converted via LG Media
Center. For details about conversion, see the Help menu [Con-
verting  video file] on LG Media Center.

1 Select of the home menu.

2 Select the desired file.
- The list is displayed on LCD.
- If there is no list, “No File” appears on LCD.

3 Press the desired file.
- The movie file is played.
- The movie file will be displayed on the horizontal screen.

Note

- Select a file you want and press  , you can delete it.

987

10

1

2

3
4
5
6

OVER THE RAINBOW : Garden of Useful 
00:0041 -00:02:23

OVER THE RAINBOW : Garden of Useful Publishing SYStem 
00:0041 -00:02:23
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Pausing
1 Press twice the middle part of LCD during playback. 

2 Press twice the middle part of LCD again to resume playback.

Using the control box

1 Press the LCD during playback.

2 Press .
- The control box appears on LCD.

3 Press to pause.

- appears on LCD.

4 Press to resume playback.

5 Press or other space to remove the control box.

Playing the previous or next file

1 Press the LCD during playback.
2 Drag the middle part of LCD in the direction of the left/right during

playback.  

- If you drag the LCD from right to left after five seconds of playing
time, the current file will be played from the beginning.

- If you drag the LCD from right to left within five seconds of playing
time, the previous file will be played from the beginning.

Using the control box

1 Press the LCD during playback.

2 Press .
- The control box appears on LCD.

3 Press / to play the previous or next file.

- If you press after five seconds of playing time, the current file will
be played from the beginning.

- If you press within five seconds of playing time, the previous file will
be played from the beginning

OVER THE RAINBOW : Garden of Useful 
00:0041 -00:02:23

OVER THE RAINBOW : Garden of Useful 
00:0041 -00:02:23

OVER THE RAINBOW : Garden of Useful 
M i 2 P t f U f l P bli hi SY00:0041 -00:02:23 00:0041 -00:02:23

A-B

OVER THE RAINBOW : Garden of Useful 
00:0041 -00:02:23

OVER THE RAINBOW : Garden of Useful 
00:0041 -00:02:23

OVER THE RAINBOW : Garden of Useful 
00:0041 -00:02:23

OVER THE RAINBOW : Garden of Useful 
00:0041 -00:02:23

Movie 2 : Present of Useful Publishing SYSt
00:0041 -00:02:23

Movie 3 : Flower of Useful Publishing SYSte
00:0041 -00:02:23

OVER THE RAINBOW : Garden of Useful 
00:0041 -00:02:23 00:0041 -00:02:23

A-B
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Speed search
1 Press the LCD during playback.
2 Drag the middle part of LCD in the direction of the left/right  during

playback and then press and hold the LCD.

Using the control box

1 Press during playback.
- The control box appears on LCD.

2 Press and hold / button for two seconds during playback. And
then release at a point you want.

Playing from a specific point
1 Press the LCD during playback.
2 Press the playing time bar to play from a specific point you want

during playback.
- The control box appears on LCD.

3 Press / / / .

- : Moves to the point of playing time before 1 minute.
If the playing time is less than 1 minute, the current file moves to
the beginning point.

- : Moves to the point of playing time before 5 seconds.

- : Moves to the point of playing time after 5 seconds.

- : Moves to the point of playing time after 1 minute.
If the remaining time is less than 1 minute,the current file moves
to the beginning point of next movie.

A-B section repeat

This feature can be set only on a current playing movie file.

1 Press during playback.
- The control box appears on LCD.

2 To set the starting point during playback, press .

- “A” icon appears on LCD.

3 To select the ending point, press again. 
Then, the Repeat feature will be set.

- “B” icon appears on LCD.

4 To cancel Repeat feature, press again.

- “A” and “B” icons disappear on LCD.

A-B

A-B

A-B

OVER THE RAINBOW : Garden of Useful 
00:0041 -00:02:23

OVER THE RAINBOW : Garden of Useful 
00:0041 -00:02:23

Movie 2 : Present of Useful Publishing SYSt
00:0041 -00:02:23

Movie 3 : Flower of Useful Publishing SYSte
00:0041 -00:02:23

Press and hold. Press and hold.

OVER THE RAINBOW : Garden of Useful 
00:0041 -00:02:23

OVER THE RAINBOW : Garden of Useful 
00:0041 -00:02:23

Release at a point
you want.

Release at a point
you want.

OVER THE RAINBOW : Garden of Useful 
M i 2 P t f U f l P bli hi SY00:0041 -00:02:23 00:0041 -00:02:23

Movie 2 : Present of Useful Publishing SYSt
00:0041 -00:02:23

A-B

00:0041 -00:02:23

OVER THE RAINBOW : Garden of Useful 
00:0041 -00:02:23 00:0041 -00:02:23

A-B
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Volume control
Touch the screen. Then keep pressing and turn the point you press on
LCD clockwise/counterclockwise during playback.

Volume up Volume down

Using the volume button 
Press the volume button on the right side of the player during play-
back. 

- :  Press this button to decrease volume. 

- : Press this button to increase volume.

EZ menu 
You can set the desired function or switch to other modes using the
EZ menu.

Touch the screen once.

Press to select the EZ menu during playback.

Bookmark
You can move to the point you set while playing the video.
• Set

Sets the bookmark.
• Move

Executes the bookmark.
• Cancel

Cancels the bookmark.

Search Speed
You can set the playing speed of movies files.
• 1 time

Plays at an original speed.
• 2 times

Plays at 2 times speed.
• 3 times

Plays at 3 times speed.

Brightness
You can adjust the brightness level from 0 to 9.
The default brightness is 6.

Delete File
• Yes : Deletes the playing file.
• No : Cancels the deleting of playing file.

View Information
Displays the information of the playing file.
(File Name, Full Time , File Size, Setting)

Movie 2 : Present of Useful Publishing SYSt
00:0041 -00:02:23

Movie 3 : Flower of Useful Publishing SYSte
00:0041 -00:02:23

Movie 2 : Present of Useful Publishing SYSt
00:0041 -00:02:23

Movie 3 : Flower of Useful Publishing SYSte
00:0041 -00:02:23

1426

00:0041 -00:02:23

Bookmark

Search  Spee

Brightness
Delete file 
View Informatio

2/5

OVER THE RAINBOW : Garden of Useful Publishing SYS



DVB-T broadcasting screen 

1 Moves to the EZ menu.

2 Battery status

3 DVB-T broadcasting display

4 Moves to the home menu.

5 Control icons
• To move to the previous/next channel  
• To capture screen display

6 Channel list icon

7 DVB-T TV/Radio display

8 Information display for the currently broadcasting channel

9 Current time/date

* When watching DVB-T, the actual time, date, and GMT time off-
sets are set automatically.  
If the displayed time is not correct, the time and timezone must
be set manually.

10 Receiving signal strength 

Note
- The player may be overheated since the player consumes more

power while enjoying DVB-T broadcast. Overheating does not af-
fect the signal receiving of the broadcast. 

- Only the UHF band broadcast is supported in this player. 
- Reception sensitivity may be different depending on signal receiv-

ing areas. 
- Signal reception may get weak while moving in bus, train, or some

places enclosed by builldings or indoors depending on countries
adopting DVB-T standard.

- HD channels and paid ones are not supported in this player. 

Entering the DVB-T mode
1 Press LCD to enter the DVB TV/Radio mode. 

2-a When there is no saved channel, the screen is displayed as
below. Press OK, the player starts searching channels. 

- Press Cancel when channel search is not completed, the last
searched channel is broadcasted. 
In that case, only the channels the player searched at that time
are saved. 

- When channel search is completed, the player moves to TV mode
and last searched TV channel is broadcasted.

- In the case only radio channels are searched, the player moves to
Radio mode and a last searched Radio channel is broadcasted.

- You can enjoy the broadcasting only on a horizontal screen. 

- The searched channels may differ depending on the service areas.

2-b Press Cancel, the screen is changed into standby mode. 

3 Press and drag right upward to return to the Home menu.
- In that case, the broadcasting stops automatically. 
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5

10

1

2

3

4

Ch - Ch +

PM 12:29 Thr, 6 November

Ch -Ch - Ch +Ch +

Ch - Ch +

9 7 68

The making of unauthorized copies of copy-protected material,
including computer programs, files, broadcasts and sound
recordings, may be an infringement of copyrights and constitute
a criminal offence. This equipment should not be used for such
purposes.

Be responsible
Respect copyrights



Viewing the channel list for TV/Radio 
1 Press while enjoying DVB-T TV/Radio. 

- Then, the list for TV/Radio is displayed on the right. 

2 Press TV/Radio to turn into TV/Radio mode. 

3 Select a channel you want to watch or listen to. 

4 Press it; you can enjoy TV/Radio broadcasting. 

- Press on TV/Radio mode, you can see only favorite channels
you previously classified as favorites. 

- You can check the list only when setting Electronic Program Guide
to off on EZ menu. For details, refer to the page 28.

Moving to the previous/next channel
1 Press the LCD once during broadcasting.
2 Drag the middle part of LCD in the direction of the left/right  during

broadcasting.

Using the control icons

1 Press to move to the previous channel.

2 Press to move to the next channel.
Ch +Ch +

Ch - Ch +

Ch -Ch -

Ch - Ch +
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Ch -Ch - Ch +Ch +

Ch - Ch +

Ch - Ch +

PM 12:29 Thr, 6 November

Ch -Ch - Ch +Ch +

Ch - Ch +

Ch - Ch +
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Ch -Ch - Ch +Ch +

Ch - Ch +

Ch - Ch +
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Ch - Ch +

PM 12:29 Thr, 6 November

Ch -Ch - Ch +Ch +

Ch - Ch +

Ch - Ch +

PM 12:29 Thr, 6 November

Ch -Ch - Ch +Ch +

Ch - Ch +

Ch - Ch +

PM 12:29 Thr, 6 November

TV Radio

U1 U1 

CTS 
S2 GOD (U)
CBS u TV
my ABC 
KES-STAR TV

TV Radio

U1 U1 

CTS 
S2 GOD (U)
MTV Nordic
my ABC DMB
KES-STAR TV

Ch -Ch - Ch +Ch +

Ch - Ch +

Ch - Ch +

PM 12:29 Thr, 6 November



cool style 

Enjoying DVB-T

27

Capturing the screen display

Press , the broadcasting screen shot is captured and saved as a
BMP file. 

- You can check the captured image on the Photo list. 
- This function is available only on DVB-T TVmode.  

Muting sound
1 Press the middle part of the screen twice while watching or listening

to broadcasting to mute it. 

2 Press the part twice again to deactivate mute operation. 
- You can also deactivate it by adjusting volume. 

Volume control
Touch the screen. Then keep pressing and turn the point you press on
LCD clockwise/counterclockwise during playback.

Volume up Volume down

Using the volume button 
Press the volume button on the right side of the player during play-
back. 

- :  Press this button to decrease volume. 

- : Press this button to inrease volume.

EZ menu 
You can set the desired function or switch to other modes using the
EZ menu.

Touch the screen.

Press to select the EZ menu during broadcasting.

Channel Search(DVB-T TV/Radio)
1 Select and press [Channel Search].
2 - When no channel is saved

1) Press [OK], and then the player starts channel search. 
2) Press [Cancel],  the screen is changed into the standby mode

for DVB-T. 
- When saved channels exist 

1) Press [OK], the previous saved channels are deleted.
And then the player starts channel search. 

2) Press [Cancel],  the screen is returned to the previously broad-
casting channel. 

Note
Press Cancel when channel search is not completed, the last
searched channel is broadcasted. 
- In that case, only the channels the player searched at that time are

saved. 
- When no channel is saved, the screen is returned to the previously

broadcasting channel.   

Multi-Lingual(DVB-T TV)
You can select the language when a broadcasting channel supports
multi-lingual broadcasting.
The default language is the first registered one in a broadcasting
channel. 
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Electronic Prog
Aspect ratio
Brightness
View Informatio
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Electronic Program Guide(DVB-T TV/Radio)
EPG(Electronic Program Guide; specified as EPG hereafter) helps
you to see what is currently being shown on the channels you receive. 
You can set ON or OFF to activate the EPG.

• Setting EPG
- On : You can activate EPG.
- Off : You can deactivate EPG.

• Basic function of EPG

• PREV
You can check the previous EPG contents. 

• NEXT
You can check the next EPG contents. 

• TV/Radio
It will toggle between DVB-T TV and Radio modes. 

• Favorite 
It will toggle the EPG between showing just "favorites" and all chan-
nels.

• Close 
You can return to the previous broadcasting channel.

• Checking the detailed channel information 
Select a program on [NOW] or [NEXT] column of EPG, a pop-up win-
dow appears. 
- It brings up more information about the corresponding program. 

• Watching DVB-T TV/Radio
1 Select a program on [NOW] column of EPG.
2 Press [Watching], you can watch or listen to the corresponding pro-

gram. 

• Reserving DVB-T TV/Radio programs
1 Select a program on [Reserving] column of EPG to reserve it.
2 The program is marked with the icon as shown blow. 
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• Canceling the reservation
1 Select and press the channel you previously reserved. 
2 Press [Reserving] again, the button is toggled into [Cancel].
3 Press [Cancel] to cancel reservation.  

• Adding a channel to the favorite channel list 
1 Select and press a channel  you want to add to Favorite.  

- When the selected program is not registered as a favorite one,
[Add to Favorite] is displayed on the bottom of the display screen. 

2 Press [Add to Favorite] to add the channel to the Favorite list. 

• Removing a channel from the favorite channel list 
1 Select and press the channel you want to remove from Favorite.

- When the selected program is registered as a favorite one, [Re-
move from Favorite] is displayed on the bottom of the display
screen.

2 Press [Remove from Favorite] to remove the channel from the Fa-
vorite list. 

Aspect ratio(DVB-T TV)
You can set the screen ratio between 4:3 or 16:9. 

The default screen ration is 16:9. 

Brightness(DVB-T TV)
You can adjust the brightness level from 0 to 9.
The default brightness is 6.

View information(DVB-T TV/Radio)
Displays the information of the broadcasting channel.
(Channel Number, Program Name, Frequency, Language Code)
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Photo viewing screen

1 Moves to the previous menu or home menu.

2 Control icons (Slide show/ Skip)

3 Enlarging/ Reducing the photo size

4 Current file number/total file numbers

5 Music/ Radio display

6 File name

7 Photo screen

8 Moves to the EZ menu.

9 Battery status

Viewing photo files
1 Select of the home menu.

2 Press the desired file.
- The list is displayed on LCD.
- If there is no list, “No File” appears on LCD.

3 Press the desired file.
- The photo file appears on LCD.

Note
- MP3 player may not be played a black-and-white photo or large-ca-

pacity file.

- Select a file you want and press  , you can delete it.
- Large-sized photos may not be opened or played.

Enlarging/ Reducing the photo size
1 Press to enlarge the photo size while viewing a photo. 
2 Press it again to reduce the size. 

- Horizontal size is longer than vertical size of a photo file will be dis-
played on the horizontal screen.

1

2
6

8

7

9

The player is not supported some JPEG Progressive files.
Download through the LG Media Center

3 5

4
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Setting the slide show
1 Press the middle part of LCD when a photo file is displayed.

2 Press the middle part of LCD again to pause.

Using the control icons

1 Press to set slide show.

2 Press to pause.

Viewing the previous or next file
Drag the middle part of LCD in the direction of the left/right during
playback.  

Using the control box

Press / button to view the previous or next photo.

Viewing photos while listening to
music/radio

Press or (you previously set on the DUAL of EZ menu) to lis-
ten to music or radio while enjoying photos. Refer to DUAL of the page

33 for the method on how to set music/radio mode in detail. 

Viewing photos while listening to music

Press . Then the control box is displayed as shown below. 

- : You can start playing music.

- :  You can pause playback. 

- / : 1. Short key: Press this button briefly, you can play the
previous or next file.            

2. Long key: Press and hold this button, you can search a
desired music file. 

Viewing photos while listening to radio

Press . Then the control box is displayed as shown below.

The mode is displayed as you previously on radio mode. 

- : You can start radio play.

- :  You can pause playback. 

- / (In Non-Preset mode): Press this button, you can find avail-
able radio station.             

- / (In Preset mode): Press this button, you can listen to the

previous/next preset channel.  

Ch +Ch - Ch +Ch -

Mode Mode

Ch +Ch - Ch +Ch -

Mode Mode

Mode ModeMode Mode

Non-Preset mode Preset mode
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Volume control
When you listen to music or radio while viewing the photo file, control
the volume. (FM radio reception is optional.)

Touch the screen. Then keep pressing and turn the point you press on
LCD clockwise/counterclockwise during playback.

Volume up

Volume down

Using the volume button 
Press the volume button on the right side of the player during play-
back. 

- :  Press this button to increase volume. 

- : Press this button to decrease volume.

24

24
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EZ menu 

You can set the desired function or switch to other modes using the
EZ menu.

Press to select the EZ menu while viewing the photo.

DUAL
You can listen to music or radio while viewing the photo file. (FM  radio
reception is optional.)
• Music : You can listen to music while viewing the photo file.

[ (Moving to EZ menu of the photo] k [Music] k [Can-
cel]/[Play Previous]/[Play Next]/[Back]
- [Cancel] : Stops the music playback.
- [Play Previous] : Plays previous music.
- [Play Next] : Plays next music.
- [Back] : Moves to the music mode.

• Radio : You can listen to radio while viewing the photo file.
[ (Moving to EZ menu of the photo] k [Radio] k [Can-
cel]/[Previous Channel]/[Next channel]/[Back]
- [Cancel] : Stops the radio reception.
- [Previous Channel] : Receives the previous channel.
- [Next Channel] : Receives the next channel.
- [Back] : Moves to the radio mode.

Slide Show
You can set the slide show to On/Off.
• On

Turns on the slide show.
• Off

Turns off the slide show.

Slide Interval
You can set the slide show interval to [2 sec], [3 sec], [4 sec],or [5
sec].

View 6 slides
You can show 6 slides on one screen.

Brightness
You can adjust the brightness level from 0 to 9.
The default brightness is 6.

Background Setting
You can set the photo you are viewing currently into
Music/Radio/Menu/Screen saver background. 
• Music Background

You can set the currently viewing photo file to music background.
• Radio Background

You can set the currently viewing photo file to Radio background.
• General background

You can set the currently viewing photo file to each menu back-
ground.

• Screen saver background
You can set the currently viewing photo file to screen saver back-
ground.

Delete File
• Yes : Deletes the playing file.
• No : Cancels the deleting of playing file.

View Information
Displays the information of the playing file.
(File Name, File Kind, File Size, Setting)
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FM radio reception screen 

1 Moves to the previous menu or home menu.

2 FM radio frequency display 

3 FM radio frequency display bar(In non-preset mode)

Channel no.(In preset mode)

4 Control icons (Play/ Mute/ Frequency search)

5 Mode changing icon

6 Moves to the EZ menu.

7 Battery status

Setting preset channels
1 Select of the home menu.
2 If you want to store the channel press [Yes], otherwise press [No].

- You can save maximum 20 channels and existing channels will be
deleted.

- In an area with weak reception, the detected channels may be less
than 20.

3 The FM radio broadcasting is received.

Listening to the FM radio
1 Select of the home menu.
2 You can listen to the FM radio.

Note
- The mode is displayed as you previously on the radio mode. 
- Press once to check the  channel list on the preset mode.

- Select a channel you want and press , you can delete it.

Muting sound
1 Press the middle part of LCD while listening to the radio. 

2 Press the middle part of LCD again to listen to the radio.
- You can also deactivate it by adjusting volume. 

Using the control icons

1 Press to set muting.

2 Press to lisent to the radio.

1

2

3

5

4

6

7

Preset mode Non-Preset Mode
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Searching the FM radio stations
Manual Search
Drag the middle part of LCD in the direction of the left/right while lis-
tening to the radio. 

Using the control icons
- Press on LCD until the and appear on Non-Preset Mode.

- Press on LCD until the and appear on Preset Mode.

Automatic Search
Drag the middle part of LCD in the direction of the left/right during re-
ception and then press and hold the LCD.

Using the control icons
1 Press on LCD until the and appear on LCD.

2 Press or , the player will search available frequency automati-
cally.
- :  The player searches previous available frequencies.

- : The player searches next available frequencies.

3 Press during automatic search, the auto search is canceled.
- Reception may be weak in some areas.
- As earphones function as antennas, only LG Electronics' ear-

phones guarantees the reception quality.

Mode Mode

Mode Mode

Mode Mode

Mode ModeMode Mode

Mode ModeMode Mode

Mode Mode

Ch +Ch +Ch - Ch +Ch -

Mode Mode

Ch +Ch - Ch +Ch -

Mode Mode

Mode Mode
Mode ModeMode Mode

Mode Mode

Non-Preset Mode (Decreases/increases step by step.)

Preset Mode (Decreases/increases channel by channel.)

Non-Preset Mode

Press the LCD for about 2 seconds.

Preset Mode

Press the LCD for about 2 seconds.
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Volume control
Keep pressing and turn the point you press on LCD clockwise/coun-
terclockwise while listening to the radio. 

Volume up

Volume down

Using the volume button 
Press the volume button on the right side of the player during play-
back. 

- :  Press this button to increase volume. 

- : Press this button to decrease volume.

EZ menu 
You can set the desired function or switch to other modes using the
EZ menu.

Press to select the EZ menu while listening to the radio.

Simultaneous View
• Photo : You can view the photo while listening to the 

radio simultaneously.
[Photo] k [ (Moving to EZ menu of the photo)] k
[Radio] k [Cancel]/[Previous Channel]/[Next
Channel]/[Back]
- [Cancel] : Stops the radio reception.
- [Previous Channel] : Receives the previous channel.
- [Next Channel] : Receives the next channel.
- [Back] : Moves to the radio mode.

• Text : You can view the text while listening to the 
radio simultaneously.

[Text] k [ (Moving to EZ menu of the text)] k [Radio]
k [Cancel]/[Previous Channel]/ [Next Channel]/[Back]
- [Cancel] : Stops the radio reception.
- [Previous Channel] : Receives the previous  channel.
- [Next Channel] : Receives the next channel.
- [Back] : Moves to the radio mode.

Delete Channel/Save Channel
Deletes or stores a radio channel.

Channel Search
You can store the FM radio channel automatically.
- The previously memorized channel will be deleted.
- Press [Cancel] to stop while searching the channel.

Radio Mode
You can select the channel mode or frequency mode.

• Preset Mode
You can set the FM radio broadcasting to channel mode.

• Non-Preset Mode
You can set the FM radio broadcasting to frequency mode.

View Information
Displays the information of the receiving radio.
(Frequency, Reserved REC Interval, Reserved REC Time , Reserved
frequency, Setting)

24

12
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Text viewing screen 

1 Moves to the previous menu or home menu.

2 Bookmark display

3 Enlarging/ Reducing the text display size

4 Displayed page percentage

5 Music/ Radio display

6 Text display

7 Moves to the EZ menu.

8 Battery status

Viewing text files
1 Select of the home menu.

2 Select the desired list.
- The list is displayed on LCD.
- If there is no list, “No File” appears on LCD.

3 Press the desired file.
- The text file appears on LCD.

Note

- Select a file you want and press  , you can delete it.
- Press [Settings] of Home Menu k [Text] k [Screen display] to se-

lect screen display.
• Portrait : Texts are displayed vertically.
• Landscape: Texts are displayed horizontally.

Enlarging/ Reducing the text display size
1 Press to enlarge the text display size while reading  texts. 
2 Press it again to reduce the size. 

1 7

6

8

53

2

4
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Viewing the previous or next page
Drag the middle part of LCD in the direction of the left/right during
playback.  

Using the skip icon 
1 Touch the left or right end of the screen while you view texts.

2 / is displayed and the player moves to the previous or next
page.

Skipping pages automatically
1 Press the middle part of LCD when a text file is displayed.

2 Press the middle part of LCD again to pause.

Speed search
Drag the LCD during playback and then press and hold the LCD.

Release at a point you want.

Release at a point you want.
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Viewing texts while listening to
music/radio

Press or (you previously set on the DUAL of EZ menu) to lis-
ten to music or radio while reading texts. Refer to DUAL of the page

40 for the method on how to set music/radio mode in detail. 

Viewing texts while listening to music

Press . Then the control box is displayed as shown below. 

- : You can start playing music.

- :  You can pause playback. 

- / : 1. Short key: Press this button briefly, you can play the
previous or next file.            

2. Long key: Press and hold this button, you can search a
desired music file. 

Viewing texts while listening to radio

Press . Then the control box is displayed as shown below.

The mode is displayed as you previously on radio mode. 

- : You can start radio play.

- :  You can pause playback. 

- / (In Non-Preset mode): Press this button, you can find avail-
able radio station.             

- / (In Preset mode): Press this button, you can listen to the

previous/next preset channel.  

Volume control
Keep pressing and turn the point you press on LCD clockwise/coun-
terclockwise while listening to the music/radio. 

Volume up

Volume down

Using the volume button 
Press the volume button on the right side of the player during play-
back. 

- When you set [Screen display] to [Portrait]

- :  Press this button to increase volume. 

- : Press this button to decrease volume.

- When you set [Screen display] to [Landscape]

- :  Press this button to decrease volume. 

- : Press this button to increase volume.

Ch +Ch +Ch - Ch +Ch -

Mode Mode

Ch +Ch - Ch +Ch -

Mode Mode

Mode ModeMode Mode

Non-Preset mode Preset mode
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EZ menu

You can set the desired function or switch to other modes using the
EZ menu.

Press to select the EZ menu while viewing the text.

DUAL
• Music : You can listen to music while viewing the text simultane-

ously.
[ (Moving to EZ menu of the text] k [Music] k [Can-
cel]/[Play Previous]/[Play Next]/[Back]
- [Cancel] : Stops the music playback.
- [Play Previous] : Plays the previous music.
- [Play Next] : Plays the next music.
- [Back] : Moves to the music mode.

• Radio : You can listen to the radio while viewing the text simultane-
ously.
[ (Moving to EZ menu of the text] k [Radio] k [Can-
cel]/[Previous Channel]/[Next Channel]/[Back]
- [Cancel] : Stops the radio reception.
- [Previous Channel] : Receives the previous channel.
- [Next Channel] : Receives the next channel.
- [Back] : Moves to the radio mode.

Bookmark
You can move to the point you set while playing the text.
• Set

Sets the bookmark.
• Move

Executes the bookmark.
• Cancel

Cancels the bookmark.

Auto Skip
Sets an interval for auto text skipping.
You can select [Off], and a value from [12 sec] to [22 sec].

Find Page
You can move to the desired parts.

Font color
You can set the text color among White, Gray, Green, Blue, Yellow,
Red. 
The default color is White.

Brightness
You can adjust the brightness level from 0 to 9.
The default brightness is 6.

Delete File
• Yes : Deletes the playing file.
• No : Cancels the deleting of playing file.

View Information
Displays the information of the playing file.
(File Name, File Size, Setting)
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Recording screen 

1 Moves to the previous menu or home menu.

2 Record display (Start/ Pause/ Continue)

3 Title of the recording file

4 Recording standby/ Recording time

5 Recording end

6 Moves to the EZ menu.

7 Battery status

How to record
1 Press REC button more than 1 second to record while listening to

the radio or in other menus.
- In FM recording: The recording time will be displayed and the recording

will start.
- In voice recording: 1) The player turns into stand-by mode for recording.

2) Press [Start] to voice recording. 
2 Press [Pause] to pause.
3 Press [Stop] to end the recording.

- Select [Continue] to resume recording.
- The recorded files will be stored under Record folder as a file

named F071116_xxxx in FM recording or V071116_xxxx in voice
recording(ModeYear Month Date_Order)

4 Refer to [Recorded file] on page 17 to play prerecorded files.

Note
If the remaining memory space is less than 3MB, the player may not
be recorded.

EZ Menu 
You can set the desired function or switch to other modes using the
EZ menu.

Press to select the EZ menu while recording radio/voice.

Recording Quality
You can set the quality of the recorded file.
- You can set [96kbps], [128kbps], or [192kbps].

VAD
In case of voice recording, recording will automatically stop upon mute
sound and will resume upon reception of the voice signal.
- You can select [On] or [Off].

View Information
Displays the information of the recording file.
(Quality, Vad, Setting)

1 6

7

5
4

2

3
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All Files
1 Select of the home menu.

2 You can confirm and play the playable list on each mode.

Note

- Select a file you want and press  , you can delete it.

Game
1 Select the icon of the home menu.

[Dynamic HEADING] game
Heading for both side of balls that mission will be 
succeed.
Do not pile up the over 5 balls in given time. 
Many kinds of items will appear.

[PIKKO] game
See the tail of wind, put PIKKO by pressing PIKKO the basket. 
Chances are just 5 times! You can get the lost chances in every 5
success by one. High score is the most succeed chances.

[Champion Batter] Game
To gain the mission point of each level, the batter should get to first
base.
If you use a pinch hitter of each level, the mission will be easily
completed.
Be careful with various ways of pitch and 11 special pitches.

[Salad World] Game
To escape vegetables, place more than 3 same vegetables, in a line
(up, down, right and right) Use magnetic and fog effect items. Fog -
the effect will be going on for 6 second. If you click one salad during
fog effect, all same vegetables can escape.

[Burning Skewered Food] Game
Complete skewered food according to order box by operating but-
ton related to materials.

2 Press the desired game file.
- For details, see the [HELP] or [Information] menu.
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Settings
Music
Play Mode
• Repeat One

Plays the current file repeatedly.
• Play All

Plays all music within the selected folder in order.
• Repeat All

Plays all music within the selected folder repeatedly.
• Random All

Plays all music within the selected folder randomly.
• Random Repeat All

Repeats all music within the selected folder randomly.

Music Speed
You can set the playing speed of MP3 files.

- You can select [0.3 times], [0.5 times], [1 time], [1.5 times], and [2
times].

- The default value is [1 time].
- MP3 files sampled at less than 32KHz can support only [1 time].

Sound Effect
- EQ: You can set the sound effect.

(AUTO EQ, NORMAL, POP, ROCK, R&B/SOUL, HIPHOP/RAP,
JAZZ, CLASSICAL, DANCE, LIVE, USER EQ)

- 3D Sound: You can experience 3D sound effects.
(Off, CLEAR, 3D EXPANDER, STADIUM, CONCERT HALL, CLUB,
ROOM, BASS BOOST, X-LIVE)

Fade In
You can gradually increase the volume to protect ears.
- You can select [On] or [Off].

Scroll Speed
Sets the speed of the file name and ID3 tag information in the music
playing mode.
- You can select [Off], [0.5 times], [1 time], [2 times], and [3 times].

Search Interval
You can select the slide show interval.
- You can select [3 sec], [5 sec], [10 sec], or [30 sec].

Background setting 
You can select the photo file for music background.
• Album Art : Displays the album jacket during playback.
• Album Art

1) The album image saved with a music file is displayed.
- Synchronize the file with album information on Windows Media

player.
2) If a photo file is saved as the same name as that of ID3 Tag

Album of a music file on the same folder, the photo is displayed
as an album art.

3) If a photo file is saved as the same name as that of a music file on
the same folder, the photo is displayed as an album art.

4) The three cases exist simutaneously, an album art is displayed in
the following order [1]-[2]-[3].

• User Image
Displays the user’s desired photo during playback.

• Default Image
Displays the basic photo during playback.

Movie
Search Speed
You can set the playing speed of movies files.
• 1 time : Searches at an original speed.
• 2 times : Searches at 2 times speed.
• 3 times : Searches at 3 times speed.

MXD Engine Effect
You can show a high-definition image of movie files.
- You can select [On] or [Off].

DVB-T 
Region Setting
You can set the reception area among 17 countries.

Electronic Program Guide
EPG(Electronic Program Guide; specified as EPG hereafter) helps
you to see what is currently being shown on the channels you receive. 
You can set ON or OFF to activate the EPG. 

Aspect ratio 
You can set the screen ratio between 4:3 or 16:9. 

Photo
Slide show
You can set the slide show to On/Off.
• On : Turns on the slide show.
• Off: Turns off the slide show.

Slide Interval
You can set the slide show interval to [2 sec], [3 sec], [4 sec],or [5
sec].

Text

Font Color
You can set the character color in the text mode.
- You can select [White], [Gray], [Green], [Blue], [Yellow], or [Red].

Auto Skip
Sets an interval for auto text skipping.
- You can select [Off], and a value from [12 sec] to [22 sec].

Screen display
You can select screen display between Portrait or Landscape. 
• Portrait : Texts are displayed vertically.
• Landscape: Texts are displayed horizontally. 

Radio
Mode
You can set the reception mode.
- You can select [Auto] or [Mono].

Sensitivity Setting
The higher, the more frequency channels.
- You can select [High], [Standard], or [Low].

Region Setting
You can set the reception area among 17 countries.

Reserved Recording
You can reserve the FM radio recording.
- You can set the frequency for reserved recording.
- You can set only one reserved recording.
- Recording can be made for maximum 23 hours and 59 minutes.

Radio background
You can select the photo file for radio background.
• User Image

Displays the user’s desired photo during playback.
• Default Image

Displays the basic photo during playback.
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Record
Recording Quality
You can set the quality of the recorded file.
- You can set [96kbps], [128kbps], or [192kbps].

VAD
In case of voice recording, recording will automatically stop upon mute
sound and will resume upon reception of the voice signal.
- You can select [On] or [Off].

Time
Sleep Reservation
When the defined time passes, MP3 player will be automatically
turned off.
- You can select [Off], [10 min], [30 min], [1 hr], or [2 hr].
- If you set the turning-off reservation, MP3 player

will automatically store files and be turned off at the reserved time.
- After MP3 player is turned off at the reserved time, the

turning-off reservation will be automatically cancelled.

Time System
You can set the current time in 12/24 hour time system.

Time Setting
You can set the current time.
- You can set years between 2001 and 2099.
- When downloading files synchronized on windows media player in

MTP mode, the time setting of MP3 player will be synchronized with
the one of the PC.

Time zone
You can set a applicable time zone on the player. 

Summer time
You can set daylight saving time system to this player’s clock system. 
• On : Applies the summer time system to this player and then one

hour is adjusted forward.
• Off: Deactivates the summer time system.

Note
When moving to other regions or countries, you have to set the Time
zone and summer time system to be compatible there. 

Display Setting
Brightness
You can adjust the brightness level from 0 to 9.
The default brightness is 6.

Theme Setting
Sets menu type.
- You can select [Icon type] or [List type].

Menu Color
You can set the color of the home menu to [Red]/[Blue].

Screen saver
After the defined time passes, the screen saver is activated to
protect display screen.  
- You can select [On]or [Off].
- When the set time for screen saver activation is the same as or

longer than that for Auto Power off, the screen saver is not activated. 
- When playing video file and performing photo slide show, the screen

saver is not activated. 

Menu background
You can select the photo file for menu background.
• Theme setting 

Displays a theme image you selected among Default Theme setting,
Leisure, Animal, Artist, Rhythm, Equalizer, and Animal skin.

• User image
Displays the user’s desired photo during playback.

Screen saver background
You can select the photo file for screen saver background.
• Default image

Displays the basic photo during playback.
• User image

Displays the user’s desired photo during playback.

General
Rebuilding
You can search the downloaded files and upgrade the list.
- You can select [Yes] or [No].
- If you select [Yes], the list will be upgraded. If you select [No], MP3

player will return to the general setting screen.
- As updating the list may take time, check the battery status in ad-

vance. 

Initialize Settings
You can initialize the setting of MP3 player.
- You can select [Yes] or [No].
- If you select [Yes], MP3 player is automatically turned off after MP3

player is initialized.
- If you select [No], MP3 player moves to the previous menu.

System Info
You can check the product information.
- The entire memory space, the used memory space, remaining mem-

ory space, the model name and firmware version are displayed.

Language
You can select the language.
- Korean, English, Portuguese, Danish, German, Dutch, French,

Italian, Norwegian, Spanish, Swedish, Finnish

Power Management
• Auto Display Off

If no button is inputted during the given time, the LCD will be auto-
matically turned off.
- You can select [Off], [5 sec], [10 sec], [30 sec], or [60 sec].

• Auto Power Off
If no button in selected in the standby mode for playing, the screen
will be automatically turned off.
- You can select [Off], [30 sec], [1 min], [5 min], or [10 min].

PC Connection Setting
• Media Device(MTP) Mode

- The MTP applies the latest technology of Microsoft to support the
multimedia devices. It is recognized as a mobile devices and com-
patible with Windows Media Player10.

• Removable Disk(MSC) Mode
- MP3 player will function as a general removable storage in this

mode.

Format
You can delete all data in the memory and initialize the memory.
- You can select [Yes] or [No].
- If you select [Yes], formatting will be made. If you selects [No], MP3

player will return to the general setup screen.
- Back up the data stored in MP3 player before initializing it.
- Deleted data cannot be recovered.

Calibration
You can adjust a focus on LCD.
- Press “+” repeatedly.
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Upgrading firmware automatically
Connect MP3 player to the PC where the LG Media Center is in-
stalled to download a new version of
firmware.

1 Connect one end of the USB cable to the USB port of the PC with
the LG Media Center installed and the other to the USB port of MP3
player.

2 The LG Media Center will compare the firmware versions of MP3
player and the server. If it detects a new firmware version, it asks
you whether to upgrade the version.

3 Click [OK] to copy new firmware to the MP3 player.

4 Upon updating, new version firmware will be copied to the MP3
player.

5 To safely remove the device, remove the USB cable.
(In MSC mode)

6 When "Firmware upgrade?" message is displayed, click the REC.

7 The firmware updating progress bar will be displayed. After the up-
grade is completed, the power will be automatically turned off.
- Wait till the player is automatically restarted.

8 You can check the firmware version in Home Menu [Settings] of

Home Menu  k [General] k [System Info].

Upgrading firmware manually
You can upgrade the firmware for addition and change of fea-
tures of MP3 player and for functional improvement.

1 Check the model number at the company website, and download
the latest version.

- http://www.lge.com k Support k Download k Software
(The contents may differ depending on the website.)

2 Decompress the downloaded files. Then, T80.rom file will be dis-
played.

3 Connect the USB cable to the MP3 player and the PC.

4 Check whether a new drive has been added in the Windows Ex-
plorer in the PC.

- The drive name may differ depending on the OS.

5 Select the T80.ROM and T80VIS.PAC  files and copy it to the newly
added drive.

- In Windows Media Player 10 version:

In MSC mode: Highest root

In MTP mode: Data folder 

- In Windows Media Player higher than 10 version: Internal Storage 

6 To safely remove the device, remove the USB cable.

7 When "Firmware upgrade?" message is displayed, click the REC.

8 The firmware updating progress bar will be displayed. After the up-
grade is completed, the power will be automatically turned off.

- Wait till the player is automatically restarted.

9 You can check the firmware version in Home Menu [Settings] of

Home Menu  k [General] k [System Info].

T80.rom

- Functions only in the Internet-connected PC.
- Back up important data before upgrading, or the data may get lost.

Back up important data before upgrading, or the data may get lost.

T80VIS.PAC
PAC file 
22,181KB

ROM file 
16,766KB
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Q :MP3 player will not be turned on.
A : Check whether the battery is remaining.
A : Connect the AC adapter and charge the battery.

Q : The screen is blur.
A : Avoid direct sun rays and adjust the brightness.
A : Check the LCD brightness.

Q : The button does not function.
A : Check whether the Hold feature is active.
A : Check whether you pressed right button.

Refer to the page 6 for using touch screen. 
A : Press the reset hole. Refer to the page 15.

Q : The noise is severe during listening to the radio, and the re-
ception is poor. (FM  radio reception is optional.)
A : The earphone functions as an antenna. 

Be sure to handle carefully.
A : Slightly change the directions of MP3 player and the ear-

phones.

Q : The player can not receive FM broadcasting.
A : The bundled earphones operates as an antenna. Stretch the

wires not to be entangled while listening FM radio. 
A : Move to other locations where you can receive the reception

and enhance its quality. 
A : Check whether you set mute. 

In that case, deactivate mute operation.(Refer to page 34)

Q : After the files are downloaded, the playlist will not show the
newly added files.
A : Upgrade the list in Setup menu.
A : Format the product and download the file.

- If you format MP3 player, all data in it will get lost.

Q : DVB-T broadcasting is sometimes interrupted while moving. 
A : Reception sensitivity may be different depending on signal re-

ceiving areas and signal reception may get weak while moving
in bus or train. 
Move to other locations where you can receive the reception
and enhance its quality.

Q : Channel search is not operated in DVB-T mode. 
A : Check whether the region setting is set correctly in

[Settings]k[DVB-T]k[Region Setting].
A : Extend the antenna completely or slightly change the direction

s of it.  
A : Move to outside to enhance signal reception if you try to use

DMB-T function indoors.  

Q : After the firmware is upgraded, MP3 player is not normally
functioning.
A : Reset the product (See page 15)
A : Back up the data and format MP3 player.

- If you format MP3 player, all data in it will get lost.

Q : Sometimes, files are not downloaded.
A : Check the PC Connection Setting of MP3 player. 

(See page 10 - 11.)
A : Check the PC Connection Setting. Some files can be down-

loaded depending on the PC Connection Setting. All files can
be downloaded in MSC mode.

Q : The PC can not recognize an MP3 Player.
A : Check the PC Connection Setting. In the case of Windows

2000, PC Connection Setting should be set to MSC in Setup
Menu.

A : Check if the USB driver on the provided CD is installed.

Q : AVI/WMV file will not play.
A : Only video files transcoded by LG Media Center 

can be played. Make sure the files to be played are converted
by LG Media Center. Refer to the LG Media Center [Help] on
how to transcode your files.

Q :Characters are not shown properly in text files.
A : If the text file is encoded in a format that your text file viewer

doesn't understand, text data seem to be garbaged or cor-
rupted.

A : You should convert the text file into Unicode on a PC which
supports your language of choice and download it.

A : Set the characters to the corresponding languages in [Settings]
k [General] k [Language].

Q : ID3 TAGs of the music are broken or are not displayed.
A : Set the ID3 TAGs to the corresponding languages in [Settings]

k [General] k [Language].
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Code Num Correction

001 From the <Download> menu on the Homepage, 
download the newest “ROM” and “VIS.PAC” files, 
and then upgrade with it. Or you can upgrade 
the firmware in LG Media Center. 
[Tools] -> [Firmware update].

002 Reset the player. (Refer to page 15)

003 Contact a LG service center near you. 

004 Delete unnecessary files to ensure enough 
space in the player.

005 Connect the player to PC and delete more than 
30MB to ensure enough space in it.

006 Connect the player to PC to delete the files/
folders.

007 Download the files again through LG Media 
Center. 

008 Set the desired image as a background again into
the player.

009 Set the mode of the player to MTP and synchro
nize files on Windows Media Player 10 or higher 
version.  

010 Connect the player to PC and format it. 
(Or activate the format function on setting menu)
[Settings - General - Format] 

011 Initialize the player.  
[Settings - General - Initialize Settings] 

012 Use the player after having the battery fully 
charged.

013 The battery is not compatible with the player.   
Use the confirmed battery.

200 Scrambled channels are not supported in the 
player. 

201 The service is not supported in the player.

When you try to use non-supported files or services, system errors
happen, or additional measures are needed in the player, the error
codes specified below may be displayed. In that case, please trou-
bleshoot the problems by referring to the corrections as below be-
fore visiting service centers.

Error code display

Code Number
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Capacity 4GB/8GB

File system FAT32

OS for MP3 Player Device Win2000/XP/VISTA

OS for LG Media Center Win2000/XP/VISTA

Interface USB 2.0

Dimensions 55.4 (W) X 98.5 (H) X 12.9 (D)

Weight 80.8g (with battery)
(Depends on the product model.)

Operating temperature 0°C + 40°C

Frequency range 20Hz ~ 20kHz

Signal-to-noise ratio 90dB

Channel response 40dB (1kHz)

Maximum output 18mW+18mW

Frequency range 87.5~108MHz

Signal-to-noise ratio 50dB 

Channel response 22dB (1kHz)

Antenna Earphones antenna

Video About 5.5 hours

Audio About 40 hours (for 128Kbps/44.1KHz EQ 
normal)

DVB-T About 2 hours

Battery (Detachable) Lithium Ion DC 3.7V 1100 mAh 
Chargeable Battery

Audio MP3, OGG, WMA, WAV (ADPCM)

Video LG AVI (30 frames), LG WMV (30 frames)

Image viewer JPG, BMP

Text viewer TXT

TFT LCD 3.0" / 260,000 colors

Memory

PC

General specifications

Audio

FM radio
(Optional according

to model)

Playback time

Power supply

Type Item Specifications

http://www.lge.com
Information related to the product is available at this site.
- By updating the firmware, you can improve the performance of the product.

Note
Some parts of the storage space of the MP3 player are usually used for storing the information that is internally treated.
Therefore, the storage capacity that can be actually used may be somewhat smaller than specified in the manual.
(The size of the storage space for the internally treated information can be changed for product upgrade without any no-
tice to the end users.)

Files

Display
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Supported file specification
MP3 Decoder
- MP3 decoding support specification including variable bit rate (VBR) MP3 Encoder

- 44.1KHz, (128Kbps, 192Kbps) Spec, 22KHz (96Kbps) Spec
WMA Decoder
- WMA (ASF-audio only) Decode Support

- (S): Stereo,  (M): Mono

OGG Decoder
- Q(-1) ~ Q(10) Support
ADPCM Decoder
- WAV File Format (MS-ADPCM) Decode

32 OK OK OK

40 OK OK OK

48 OK OK OK

56 OK OK OK

64 OK OK OK

80 OK OK OK

96 OK OK OK

112 OK OK OK

128 OK OK OK

144 OK OK OK

160 OK OK OK

192 OK OK OK

224 OK OK OK

256 OK OK OK

320 OK OK OK

Bitrate 32KHz 44.1KHz 48KHz
Mpeg1
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